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Practice Setup 
 
There are certain steps that need to be taken to set up your LeonardoMD 
Renaissance site. The steps in this guide are to be completed by the Practice 
Administrator. This is the person who will oversee the implementation process and 
will be responsible for the practice administration. Unless the practice is large and 
complex, there should be only one administrator per practice. The administrator is 
generally the doctor, the office manager or the IT manager.  
 
Administrator Setup coincides with our live courses 101 and 102. Signup for these 
classes can be found in our Training Catalog or Training Schedule within the Support 
section of LeonardoMD Renaissance. We also have pre-recorded training videos 
available at http://www.leonardomdmedia.com/login.asp. Please contact our 
Customer Support at 858-450-5045 to receive the username and password required 
to view the training videos.  
 
Before you begin your LeonardoMD Renaissance setup, you will need to configure 
your Internet Explorer browser. This will need to be done on every computer that 
your office will be using to access LeonardoMD Renaissance.  
 

1. Add https://renaissance.leonardomd.com to Internet Explorer’s Trusted Sites 
security zone: 
Go to Tools > Internet Options > Click on the Security Tab > Click on the 
Trusted Sites icon then click the Sites Button > Type 
https://renaissance.leonardomd.com in the top line and click Add. Click OK 
to exit. 

2. Optimize Pop-Up Blocker settings:  
Go to Tools > Pop-Blocker Settings > Add 
https://renaissance.leonardomd.com > Click OK to exit. 

3. Disable additional Pop-Up Blockers: 
Google, Yahoo, and MSN toolbars all come with their own Pop-Up Blockers 
that need to be disabled before using LeonardoMD. To determine if you have 
additional Pop-Up Blockers, do the following: Go to the View Menu > Hover 
over Toolbars. If you see Google, Yahoo, or MSN, check them off so they will 
show. Find these Toolbars on your Internet Explorer Interface and look for an 
icon that has a phrase that says either “X number Pop-Ups Blocked” or “Pop-
Ups Okay”.  For Google completely remove the Pop-Up Blocker by clicking on 
the Settings Button > Click on the More Tab > Uncheck the boxes 
associated with Pop-Up Blockers > Click Apply then OK to exit. For Yahoo 
and MSN Pop-Up Blockers right click on the Pop-Up Blocker icon and select 
Disable. If Disable is not an option always make sure the icon says Pop-Ups 
Okay when working in LeonardoMD. 
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1. Processing Your Invitation 
To join a practice as a staff member you will need to be invited by the administrator 
of the practice. The invitation is sent via email. When you receive the invitation 
follow the instructions below to process the invitation: 
 
NOTE: The first invitation is sent to the practice administrator by LeonardoMD. 
 

1. You will receive an email titled LeonardoMD Renaissance Staff member 
invitation. 

2. Click the link provided in the email, or copy and paste it into the address bar 
of Internet Explorer. 

3. The link will automatically take you to LeonardoMD Member Services.  
Member Services is independent of Renaissance, so you can manage a single 
email address, password, and member profile for multiple Renaissance 
practices. 

4. In Member Services, you will be required to fill out some necessary 
information.  All questions must be answered in order to successfully join a 
practice. 

a. In completing this information, you will be asked to create a secret 
question and answer to be used for determining your authenticity 
in the event that you forget your Renaissance password. 

b. If you forget your password, go to Member Services, click the link 
signifying you have forgotten your password, and answer your 
secret question. Type in a new password and press Update 
Password. 

c. If you do not remember the answer to your secret question, you 
can click the link at the top to reset your password by email. 

5. After you have completed the necessary fields, click Save Profile, and you 
have successfully joined a practice.   

6. Sign into your practice by clicking Renaissance Sign In>>, in the upper 
right hand corner of the Member Services page.  You will be redirected to 
the Renaissance Sign In page. 

 
NOTE: If your email is being used in another Renaissance site, follow these steps: 

 
1. Type and confirm your password to accept the invitation and join the practice.  
2. If you successfully joined the practice, click on Renaissance Sign In >>, in 

the upper right hand corner, and it will take you to the Sign In page. 
 
 
2. General Practice Setup 
This step contains certain setup features that will help to customize your site for your 
practice. These next few steps are accomplished from the Setup section within your 
site.     
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Practice Profile 
 

1. Select Setup in the System Menu (upper right corner) of LeonardoMD 
Renaissance. 

2. From Setup Home, select Practice Profile. 
3. Click Edit in the Practice Information section, and enter your practice 

information. 
4. A logo and practice website link can be entered (optional). 
5. Click the Save button or click the  icon in the Leonardo toolbar (upper 

right.) 
6. Click Edit in Section Settings. 

a. Make any changes that you can at this point. However, you will 
likely be unfamiliar with several of the sections here. This is okay; 
you will become familiarized with them later and can return to 
finish the setup. 

b. Click Save when complete.  
7. Review your Subscription Information to ensure that it is correct. If it is 

incorrect, contact LeonardoMD Customer Service. 
8. Review your Billing Information for accuracy and only Edit if necessary. 

Editing this information will send an email to the LeonardoMD Billing 
Department.  

9. Return to Setup Home by clicking the link in the left navigation box. 
 

Practice Administration 
 

1. From Setup Home, select Practice Administration. 
2. Click Edit in Security Settings. 

a. Specify a Password Reset Frequency for your practice.  This is 
the length of time before all staff members in your organization are 
required to reset their password. 

b. Specify the Timeout Length for your practice.  This is the length 
of time your system can be left idle before users are automatically 
signed out for security purposes.  Practices in a hospital or busy 
setting should lower the timeout length to prevent unauthorized 
use. 

c. For extra security, you can specify a practice wide password here. 
This is the Practice Password field on the homepage. If set, it 
would require your staff to enter two passwords at sign in, one for 
the practice and one for their personal. 

d. The Allowed IP Ranges section, if needed, allows you to specify 
which computers users are allowed to log in on. You can also 
specify that certain users not be allowed to log in outside of certain 
IP ranges. This would be useful if you do not want certain members 
of your practice logging in outside of your office. 

e. The Allowed Time Ranges section is similar to the Allowed IP 
ranges, but instead it allows you to put time limits for when staff 
members can log in. 

f. When finished with this section press Save. 
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3. Return to Setup Home by clicking the link in the left navigation pane. 
 

Groups & Permissions 
 

Groups & Permissions provide an easy way to set permissions for staff members. A 
Permission is an allowance to perform certain activities within certain sections of the 
application. For example, you may not want a biller to see your Chart Documents. In 
this case you would give them “No Access” rights to the Chart Documents section. 
Another example would be that you may not want a transcriptionist to be able to 
delete a Chart Document, but you would want them to be able to edit them. In this 
case you would give them “Edit” rights. 

 
It would be an overwhelming task to set permissions for every member that gets 
added to the system. This is the point of Groups. Groups are a predetermined set of 
permissions for different types of members. By adding a member to a group, you are 
assigning them certain permissions for every section within LeonardoMD 
Renaissance. 

 
View/Edit the Permissions Assigned to a Group 

 
1. From Setup Home, select Groups and Permissions. 
2. Select a group out of the list. 
3. Select the Modify the Permissions for This Group icon  in the Leonardo 

toolbar. 
4. You will notice that the sections that appear here correspond to each section 

within the application. 
5. Make any changes as you see necessary.  
6. If changes are to be saved, click Save . If changes are to be discarded click 

Cancel . 
 
Add New Groups  

 
1. From Setup Home, select Groups and Permissions. 
2. Select the New Group link in the left navigation pane. 
3. Enter a Group Name. 
4. Choose the appropriate Membership for the group. 
5. Click Save. 
6. Set the permissions for the group (see above for instructions.) 
7. Click Save. 

 
NOTE: Even though a staff member may be a member of a certain group, you can 
still allow them higher permissions for individual sections. Individual permissions 
override group permissions. To do this, click on the Permissions button  within 
the Staff Members detail page. 

 
NOTE: The default groups created by LeonardoMD Renaissance are sufficient for 
most of practices. The need to create new groups depends mainly on the processes 
of the practice. The Practice Administrator should make these decisions. 
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3. Personalize Profiles 
This section allows you to create profiles to save groups of customized settings which 
can be loaded by practice members. Nearly every page within Renaissance is 
customizable. You can change the colors, layouts, defaults, etc. Personalize Profiles 
allows you to save these groups of settings. When you log on for the first time, you 
will be prompted to choose a setting. Since you will not have any practice or 
personal profiles yet, you will have to choose a system setting.  
 
Setup Practice Profiles  
 
As the Practice Administrator, it is your job to find the best profiles for your practice. 
Navigate through the application and adjust your personalizations. The 
personalizations can be changed on every page by clicking  in the Leonardo 
toolbar, or you can go to Setup > Personalize.  
 
Create Personalization Settings 
 
When all of the desired personalizations have been set, create a Personalization 
Profile. 
 

1. Click on Setup in the upper right corner of the screen. 
2. Click on the Personalize Profiles link. 
3. Click the New Profile link in the left navigation pane. 
4. Enter the Name of the profile. 
5. In the Description field, provide a brief explanation of the settings. 
6. Select the Scope. In this case it will be for the Practice, unless you only want 

the profile to be used by yourself. 
7. Select Yes in the field Replace Instances of You with Current Member:. 

If you set a section default to yourself, then the default will become the 
person who is signed in. For example, if you set the default Inbox staff 
member to be yourself, then anybody using this profile would have the 
default Inbox set for them.  

8. Choose whether or not you want Optional Dialog Boxes to appear. 
9. Click Save. 

 
Apply Personalization Settings 
 

1. Click on Setup in the upper right corner of the screen. 
2. Click on the Personalize Profiles link. 
3. Locate the profile you wish to use and click the Apply link associated with it.  
4. When prompted click OK. 

 
Edit a Profile 
 

1. Apply the profile that you wish to edit. 
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2. Navigate through the application making any personalization changes you feel 
necessary.    

3. Navigate back to the Personalize Profiles under Setup. 
4. Click on the name of the Profile which is a link. 
5. Click on Edit  
6. Make any necessary changes in the form. 
7. Click Save. 

 
NOTE: If you click on the Personalizations toolbar icon  within the Personalize 
Profiles page, you can choose to be prompted as to which profile you want to use 
every time you sign in. 
    
 
4. Staff Members Setup 
The staff members section serves a few purposes. First, it captures demographic 
information about your staff members such as phone numbers, addresses, 
birthdates, etc. Next, it allows them to be invited to the system so that they can log 
into the practice and perform their daily tasks.  
 
Adding and Inviting Staff Members  
 

1. In the menu bar, hover over Office and select Staff Members. 
2. Click the New Staff Member link on the left navigation pane. 
3. Enter the required information for the new staff member: 

a. First Name 
b. Last Name 
c. Email Address (required to send invitation email) 

4. All other information is optional and can be entered at a later time. You 
should have the staff member enter the information when they first log in. 

5. Click Save. 
6. Click OK when you receive the instructional warning. 
7. Assign the staff member to a permission group by clicking the Group 

Permissions toolbar button .    
8. Click the radio button in the Membership Column to associate the new staff 

member to one or more groups. The default Everyone group will always 
remain selected. When finished click Save. 

9. If you wish to override this particular staff members permissions, without 
overriding his or her group permissions, click on the Permissions button . 
Make the appropriate changes and click Save.    

10. If the new staff member is a physician subscribing for a provider license, Edit 
the Provider Information section, and click Yes on the Provider radio 
button. Click Save. 
NOTE: Ensure that the remaining information is filled out at some point. You 
can fill in this information at a later time, but ensure that it does get filled out 
for billing purposes.  

11. Before the new staff member can gain access, they must process an email 
invitation.  From the Staff Member detail page, click the Send Invitation 
toolbar icon  . 
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12. When the email dialog opens, edit the default message, and click Send. 
13. Click OK. 

 
 
 
Editing a Staff Member 
 

1. Click the name of the staff member that you wish to edit from the list. 
2. Edit the staff member information by clicking the Edit toolbar button . 
3. Click Save. 

 
 
5. Schedule Setup 
The aspects described below are items that should be completed prior to any 
scheduling activities. 
 
Locations 
 

1. Before the appointment calendar can be used, the locations for appointments 
need to be specified. 

2. In the menu bar, hover over Schedule and select Locations. 
3. Click New Location in the left navigation box. 
4. Specify a Name for the new location (i.e. San Diego Office, 4th Street Office, 

Sharp Memorial Hospital, etc). 
5. Choose a Place of Service for the location. Select a value from the drop-

down list. Whenever this location is selected in an encounter, treatment, or 
superbill, this value will automatically populate the Place of Service field. This 
corresponds to block 24B of the CMS-1500 form and is a required value for 
837 Professional claims. 

6. Select a Location Type if necessary. Select a value from the drop-down list. 
If you are unsure of which option to select, we recommend using Service 
Location. 

7. Enter the Address and Phone Numbers of the location. 
8. Click Save. 
9. Repeat this process for all locations where appointments will be scheduled. 

 
Appointment Types 
 
The Appointment Types feature helps appointment scheduling by automatically 
entering the default duration, location, and resources while scheduling repetitive 
appointments. Appointment types also set the appointment color displayed on the 
calendar. 

 
1. Hover over Schedule and select Appointment Types. 
2. Click New Appointment Type in the left navigation pane. 
3. Enter a Name (Consultation, Follow-up, New Patient, etc.). 
4. Enter the Duration for the appointment type.  This duration can be 

overridden when scheduling appointments if needed. 
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5. Enter a Default Appointment Reason for this appointment type (optional). 
When this Appointment Type is selected when creating an individual 
appointment, the Reason field in that appointment will default to the value 
that you entered. You can enter up to 100 characters. 
NOTE: This will overwrite any value you may have input before selecting the 
type, so if there is not a clear default reason for the type you may want to 
leave this blank so it does not overwrite any existing input values. 

6. Selecting a Location for the appointment type is optional. However, this 
value will default the location when the Appointment Type is selected during 
appointment creation.  

7. You can also associate Resources to the Appointment Type. When an 
Appointment Type is selected that contains resources, the resources 
automatically populate in the appointment. For more information on 
Resources, see the Help system within LeonardoMD Renaissance . 

8. Setting the Remove Copay Due to No will exclude any copay due whenever 
a new encounter, treatment or superbill is created. 

9. At this point, you will not yet have any Diagnosis or Procedure Code Sets 
created in your site. Later in the setup process you will learn how to create 
these. Once created, you can select a default diagnosis and procedure code 
set for Appointment Types. When a new encounter or superbill is created for 
an appointment with this appointment type, its diagnosis code set will default 
to the one selected. This will streamline your work. 

10. To associate an Appointment Type to a color, press the Color button and click 
on a color out of the palette. This color will appear on certain calendar views. 

11. When finished click Save. 
12. Repeat these steps as necessary. 

 
Appointment Slots (Optional) 

  
Appointment slots are scheduling guides.  They can be useful tools for finding 
available appointments in a busy schedule.  Examples of appointment slot names are 
“Memorial Hospital Clinic” or “Operating Room Block Time.”  Remember, slots are 
guides to aid in scheduling actual appointments in the Appointments section.  
Practices with a low volume of appointments do not generally design the 
Appointment Slots section as comprehensively (if at all) as practices with a higher 
volume of appointments.  

 
1. To create appointment slots, hover over Schedule and select Appointment 

Slots. 
2. Select the available Schedule for the staff member you want to create slots 

for. 
3. Use the calendar in the left margin to find the week for the first appointment 

slot. 
4. Click on an available start time in the calendar and right click your mouse to 

select New Slot. 
5. Give the slot a Name. 
6. Click Types and select one or more appointment types used by appointments 

during this appointment slot (if the appointment type needed has not been 
entered, select New Appointment Type.) 
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7. If you want to create this appointment slot for multiple staff members, select 
Staff Members and add additional staff by highlighting their name and 
pressing Add. 

8. Set the Block Type for the slot. A slot with the block type set to Exclude will 
disallow scheduling at the time of the slot. This may be good for vacations 
and lunches. 

9. Enter the appointment slot Start Date and Start Time. 
10. Enter the duration in minutes, or click the Time toolbar button  to select an 

end time. 
11. Enter the Allowed # Appointments during this slot. 
12. Choose whether you want to set the Allowed # Enforcement Prompt to 

Overridable Warning Conflict Prompt (allows you to schedule more 
appointments than the number you previously set) or Strict Non-Overridable 
Conflict Prompt (will not allow you to schedule more appointments than the 
number you chose.) 

13. You may need to define a recurrence pattern for this appointment slot 
(weekly, monthly, etc.). Click Recurrence. 

14. Determine the recurrence pattern.  

 
Example: A bi-weekly Wednesday Office Clinic Appointment Slot 

 
15. Set the range of the reoccurrence. 
16. Press OK to close the dialog. 
17. Click Color to select a color for the appointment slot. 
18. You may want to check conflicts for the slot. Click Check Conflicts to check 

all existing appointments and appointment slots for conflicts with this new 
appointment slot. A dialog will display showing a count of the conflicts and 
you can view the detail. 

19. Save the new appointment slot, or click Save and New to create another 
new appointment slot for this staff member (repeat steps 5-13.) 

20. To view an Appointment Slot, go to the Day View in the Appointments 
section. The Appointment Slot will display as the colored section (example is 
green) behind any appointments.                                                                           
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6. Insurance Companies 
The Insurance Companies section allows you to define the insurance companies that 
are billed by your practice. Once an insurance company is defined, you can specify 
the insurance plans offered by the company. For example, Health Net (Payer ID 
95567) is an insurance company. Individual and Family HMO is a plan offered by 
Health Net. Blue Cross of California (company) and Prudent Buyer Plan PPO 
(plan) is another example. Input of the Payer ID field is required if your practice 
submits electronic 837 Professional claims. Your clearinghouse can provide you a list 
of insurance companies and their Payer IDs as a reference. The Payer ID lists for our 
partnered clearinghouses, Ingenix and Navicure, can be found directly within 
Leonardo. We recommend that you take care not to input duplicate insurance 
companies, as this will minimize the usefulness of your practice data for reporting 
purposes. 

Adding New Insurance Companies 
 

1. To add a new insurance company, hover over Registration and select 
Insurance Companies. 

2. Click the New Insurance Company link in the left navigation pane. 
3. Enter the Name of the insurance company. You can enter up to 35 

characters. For CMS-1500 claims, this will be combined with the insurance 
plan name and used in blocks 11c, 9d, and in the form header. For those 
practices using our partnered clearinghouses, Ingenix or Navicure, you can 
click on the Select Company/Payer ID button above Name to find the 
correct insurance 
company and payer 
id from our 
search feature. 
Be sure to choose 
the 
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appropriate Receiver. 
4. Next, enter the Payer ID. You can enter up to 25 characters. Whenever this 

insurance company is selected in an insurance plan, this value will 
automatically populate the Payer ID field. This is a required value for 837 
Professional claims.  
NOTE: While only the Name field is required, you will need to complete the 
Payer ID field in order to process electronic 837 Professional claims for this 
insurance company. If your clearinghouse populates these for you once the 
837 file is submitted to them, you still need to enter a value in order to pass 
our 837 validation. In that case, we recommend inputting: 00000. 

5. Fill in the Eligibilty Payer ID if you are going to be doing Eligibility checking 
from LeonardoMD Renaissance. You can press the Search button  to search 
from lists already loaded into Renaissance from our supported clearinghouses, 
Ingenix and Navicure.  

6. Enter the Payer Secondary ID Type and Payer Secondary ID if there is 
one for the insurance company. 

7. Select the Default Claim Type for the insurance company. This setting 
reminds you when you are submitting claims what the preference claim type 
is for the insurance company. 

 
 
 
 

 
8. The setting NPI Only (no legacy numbers) is one that directly affects how 

provider identification numbers are submitted on claims. In a No option is 
selected, all applicable provider and physician numbers (ie: UPIN, Medicare 
PIN, etc.) will be submitted. The NPI will still be submitted if it is available 
when a No option is selected. If NPI Only is set to All Claim Types and 
Electronic Eligibililty (270) or one of the other options, all non NPI 
physician identification numbers will be eliminated from the claim. 
NOTE: Please reference our Help System  for specifics on which CMS 1500 
boxes and which 837 Professional loops and segments this affects. 
  

New CMS 1500 Settings 
 
There are several settings regarding CMS 1500 Block Behaviors that you will want to 
set as situations arise. There are a few you will most likely want to set now and then 
you can adjust the more advanced settings later. 

1. Choose Yes to Use Medicare Secondary Rules if you want to use the 
Medicare rules when creating the claim for Medicare as the secondary 
insurance. Please reference our Help System for specifics on which Block 
Behaviors this affects. 

2. Choose the New Form Header Format for CMS-1500 claims. Choose Use 
default rules (3 lines) to include a 3 line form header (which combines the 
first and second address lines from the insurance plan into one line). Choose 
Use 4 lines to include the 2nd address line on its own line. Choose Use 3 
lines (company name only) or Use 4 lines (company name only) to 
exclude the insurance plan name from printing. 
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3. Select the Block 24A behavior for CMS-1500 claims. Choose Use default 
rules to populate the From and To fields according to the default rules, which 
are to leave the To field blank if the same as the From field, except for claims 
with an insurance type of Blue Cross or Blue Shield. Choose Always enter 
"To" date of service to populate the To field even if same as the From field, 
for claims for this insurance company. 

 
Electronic Claim Settings and Electronic Eligibility Settings 

 
These are two areas where more advanced settings can be changed as required by 
insurance companies. Please Reference our Help System for more information on 
these fields.  

 
Old CMS 1500 Settings 

 
CMS 1500 claim forms are no longer used. 

 
To finish the New Insurance Company registration, add any Comments and press 
Save. Repeat these steps as necessary to create all your insurance companies. 
 
 
 
 
 
7. Insurance Plans 
The Insurance Plans section allows you to define the insurance plans that are 
selected in the Insurance Coverages section. First an insurance company is defined, 
then you can specify the insurance plans offered by the company. 

 
Creating Insurance Plans 
 

1. Hover over Registration and select Insurance Plans. 
2. Select New Insurance Plan from the navigation pane. 
3. Choose the Type of the insurance plan. Select a value from the drop-down 

list or click  to open the dynamic pick list to add an additional value. The 
default system values in the list are Medicare, Medicaid, CHAMPUS, 
Other, Group, FECA, Blue Shield, and Blue Cross. These correspond (or 
are mapped to) block 1 of the CMS-1500 form. 

4. Select the Claim Filing Indicator. This is the code identifying which type of 
claim results when this plan is included. Select a value from the drop-down 
list. This value is required for 837 Professional claims. 

5. Press the search button   next to Insurance Company to find the correct 
insurance company. If the company is not in the list, press the New Insurance 
Company button at the bottom of the dialogue.  

6. Enter the Plan Name (i.e. Prudent Buyer Plan, PPO, etc.).  
7. At this point, you will not have any Fee or Modifier Schedules to choose 

from. You will learn how to create these later. Once they are created, you can 
designate a Fee and Modifier Schedule for an Insurance Plan. When this plan 
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is selected as the primary insurance for an encounter, treatment, or superbill, 
then the fee and modifier schedules will be set to this value. 

8. When you select an insurance company the Payer ID will be set to the payer 
ID from the company. This is a required value for 837 Professional claims. If 
the company does not have a payer ID, you can enter 00000 here to pass the 
837 validation. Also the Eligibility Payer ID, Payer Secondary ID Type 
and Payer Secondary ID will populate with the information from the 
insurance company if available.  

9. Enter the Address and contact information into the remaining fields. 
10. When finished click Save. 

 
 
8. Custom Codes 
All current CPT, ICD-9 and HCPCS are already included in the system. However, you 
may have codes for your practice that are not in the standard AMA code list. Or you 
may just want to have a more user friendly description than the official code. You 
can create custom diagnosis, procedure and modifier codes for these reasons. For 
custom procedure codes you can enter a dollar amount. Similarly, you can enter 
percentage values for custom modifier codes. At this point you might want to start 
the process of adding custom codes to the system.  
 
New Custom Codes  

 
1. Hover over Codes and select Custom Diagnosis Codes, Custom 

Procedure Codes or Custom Modifier Codes. 
2. Click the New Custom Code link in the left navigation page. 
3. Fill out the form. 
4. Press Save. 

 
NOTE: Whenever a custom code is displayed it is followed by a #. 
  
 
9. Code Sets 
The Code Sets section provides creation of sets of frequently used diagnosis and 
procedure codes. When performing charge capture in an encounter or treatment you 
can select a code set and choose from just those codes. This will save time as 
opposed to entering criteria and searching through thousands of possible codes. 
Choosing from a code set will allow you to quickly select from a known set of related 
codes. When a code set is created it is specified as either for diagnosis codes or 
procedure codes, and whether it is available in Encounters, Treatments, or both. As 
many codes as needed can then be added to the set. Using personalization you can 
specify a default diagnosis and procedure code set to be used when creating new 
encounters and treatments. You can also specify a diagnosis and procedure code set 
for appointment types. Then when an encounter is created based on an appointment 
of that type, the code sets will be the default. Code sets can include both the 
provided CPT® and HCPCS codes for procedures or ICD-9 codes for diagnoses, as 
well as any custom codes that you create. 
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New Code Sets 
 

1. Hover over Codes and select Code Sets. 
2. Click New Code Set in the left navigation box. 
3. Name the code set.  
4. Select the code set Type. Diagnosis or ICD-9 codes and Procedure or CPT 

codes can be selected. Code sets only hold diagnosis or procedure codes, not 
both. 

5. Select the Scope of the code set. Choose Encounters to specify the code set 
is only available when creating or editing an encounter. Choose Treatments 
to specify the code set is only available when creating or editing a treatment. 
Choose Both to allow the code set to be used in either Encounters or 
Treatments. NOTE: Encounters are used for quick office visits and minor 
procedures, whereas Treatments are used primarily for procedures and 
extended hospital stays. 

6. Add any Comments as needed. 
7. Click Save. 
8. To add codes to the code set, click Manage in the Selected Codes section. 
9. Search for the codes to be added to the code set.  You can search by the code 

number or short description. 
10. Click to highlight the codes that need to be added to the code set. 
11. Click Add. 
12. To view the long description, highlight the code or codes and click Long 

Description. 
13. When finished click OK.  

 
NOTE: To select several codes at one time, hold your keyboard Ctrl or Shift keys 
and click the mouse.  Also, you can double click on single codes to Add (rather than 
clicking Add). 
  
Code Sets in Encounters and Treatments 
 
Encounters use the same code sets as treatments, but they are organized differently 
because encounters capture office visit charges.  Encounters provide a quick way to 
charge for repetitive office procedures.  Many practices only create one diagnosis and 
one procedure code set for encounters to emulate paper “charge slips”.  However, 
numerous code sets may help practices organize codes more efficiently. 
 
Default Code Set 

 
Each user may specify which default code set appears automatically when a new 
encounter is created by personalizing Encounters.  As with all personalization 
settings, this step must be completed by each user. 
 

1. From the Encounters list view click the Personalization toolbar button . 
2. In Other Settings select the default diagnosis and procedure code set for 

new encounters. 
3. Click Save. 
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NOTE: After the creation of Codes Sets, you can go back and link appointment types 
to a specific code set. When a new encounter is created for an appointment with this 
appointment type, its diagnosis code set will default to this. 
 
 
10. Charge Slips 
The Charge Slips section provides the ability to create customized, printable PDF 
forms based on patient, appointment, diagnosis and procedure information. A 
practice can create as many charge slips as necessary to fully organize the main 
procedures of that office (ie: you may have different charge slips for office visit, 
surgery, etc.) Charge slips can be linked to appointment types so that an entire days 
worth of charge slips can be printed at one time from the Patient Flow View 
Schedule. 
 
New Charge Slip 

 
1. Hover over Codes and select Charge Slips. 
2. Click New Charge Slip in the left navigation box. 
3. Name the charge slip. 
4. Click on the Appointment Types button and select the appointment types 

you want to associate the charge slip to by clicking the name and then 
clicking Add. When you are done select OK. 

5. Choose whether you wish to display the Practice Logo, Practice Name, and 
Charge Slip Name printed on the top of the charge slip. 

6. Choose the Section Order you want displayed. Typical workflow would be 
ordered Patient Demographics, Diagnoses, Procedures, and Additional 
Information. 

7. Select the Patient Demographics you would like displayed. Click to select 
each field and then click Add. You can also arrange the order of the patient 
demographics by using the Move option at the right of the Selected box. 
Click on the patient demographic you wish to arrange and then choose the up 
or down arrows to position the field. 

8. Choose which Diagnoses to display. Set the Diagnosis Display to Code and 
Description or Code Only. 

9. Select whether you want to Categorize Diagnoses By Code Sets. You must 
already have Code Sets created for this to display. Codes will be grouped by 
their code set and will display the code set name.  

10. Click the Diagnoses button to search for codes to display on the charge slip. 
You can search one at a time for a certain code or you can choose to search 
in a particular Code Set which will bring up all the codes you have already 
grouped together. You must still go through the search and select 
process even if you have already set the Categorize Diagnoses By 
Code Sets to Yes. The charge slip won’t categorize the codes unless 
they have first been chosen to display. 

11. Choose which Procedures to display. Set the Procedure Display to Code 
and Description; Code, Charge and Description; Code and Charge or Code 
Only. 
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12. Select which Fee Schedule you wish to use if you are choosing to display the 
Code and Charge. If you have not created a fee schedule yet, you can save 
the charge slip and come back to add it later. 

13. Select whether you want to Categorize Procedures By Code Sets. You 
must already have Code Sets created for this to display. Codes will be 
grouped by their code set and will display the code set name.  

14. Click the Procedures button to search for codes to display on the charge slip. 
You can search one at a time for a certain code or you can choose to search 
in a particular Code Set which will bring up all the codes you have already 
grouped together. You must still go through the search and select 
process even if you have already set the Categorize Procedures By 
Code Sets to Yes. The charge slip won’t categorize the codes unless 
they have first been chosen to display. 

15. Add any Additional Information you wish to have printed on the charge 
slip. 

16. Add any Comments and press Save. 
 
 
11. Fee Schedules 
The Fee Schedules section provides creation of fee schedules based on the latest 
version of CPT® and HCPCS codes and their associated RVU and Medicare fees (non-
facility), as well as any custom procedure codes. To create a fee schedule you specify 
a unique name, locality, and multiplier. The multiplier is a value (e.g. 1.3) and then 
an election of either RVU or Medicare fee. When the new fee schedule is saved, a fee 
schedule amount is calculated for every CPT and HCPCS code. 

 
 

New Fee Schedules 
 

1. To create a new fee schedule, hover over Billing and click Fee Schedules. 
2. Click New Fee Schedule in the left navigation box. 
3. Give the fee schedule a Name (example, Dr. Jones’ Standard). 
4. Click Locality and specify your locality by scrolling down the list. 
5. Specify the Multiplier type: 

a. RVU = Relative Value Units 
b. Medicare  

6. Enter a RVU conversion multiplier or a Medicare mulitpler value. 
7. Press Save. 
8. The system will calculate all procedure codes and return your new fee 

schedule. 
 
Note: Typically, practices only create one standard fee schedule to bill against. 
 
Override Codes 

 
Once a Fee Schedule is created, you can choose to override the dollar amount for 
certain codes. This way, if you charge a specific amount, this amount can be 
reflected in the charge process. Codes can be overwritten at two levels: the fee 
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schedule level, which will store the overridden amount and the individual level, which 
will allow a one time override for specific instances. 
 

To override codes at the fee schedule level:    
1. From the Fee Schedule detail page click Manage in the Override Codes 

section. 
2. In the Search For field type the code or phrase you want to search for. 
3. In the Search In drop-down list select either the Code or Short Description 

to search in. 
4. Click Search to run the search and display up to the first 250 matching 

records in the Available list.  
5. Check the Show all in available list when opened box to display up to the 

first 250 records when the list is opened. Clear the box and the list will open 
with no records displayed.  

6. Click on a code in the Available list and click Add -> to move it to the 
Selected list. You can also double-click on an item to do same. To select 
multiple items press Ctrl and then click on multiple items to highlight them, 
then click Add ->. 

7. Click on an item in the Selected list and click <- Remove to clear it from the 
Selected list. You can also double-click on an item to do same. To select 
multiple items press Ctrl and then click on multiple items to highlight them, 
then click <- Remove. 

8. To view the long description for codes select as many as you want from both 
lists using Ctrl+Click and click Long Description.  

9. Click OK or press Alt+O to close the dialog and save the override codes. 
10. Click Cancel or press Alt+C to close the dialog without saving your changes. 
11. Codes in the list, which have not yet been overridden, will appear in red. To 

override the value of these codes, press the Edit button next to the code.  
12. In the Multiplier line enter the override amount. 
13. Press Save. 

 
 
Default Fee Schedule 
 
If you use a particular fee schedule regularly, or if you only have one, you can 
specify a default fee schedule to be selected for all new encounters, treatments or 
superbills. To do so, go to Setup > Practice Profile and edit the Section Settings. 
Scroll down to the Billing Settings and set the Default Fee Schedule. You can also set 
the Default Modifier Schedule here.  
 
NOTE: Now that you have Fee Schedules created, you can associate Insurance Plans 
to a Fee Schedule. That way, when that plan is selected as the primary for an 
encounter, treatment or superbill, the fee schedule will populate automatically. Most 
practices only use one fee schedule. 
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12. Modifier Schedules 
Modifier Schedules allow you to designate the percentage for each modifier code to 
increase or decrease the fee schedule procedure amount.  A modifier schedule must 
be created before modifier codes can be used.  
 
New Modifier Schedule 

 
1. Hover over Billing and select Modifier Schedules. 
2. Click New Modifier Schedule in the left navigation box. 
3. Enter a Name of your choice. 
4. Click Save. 
5. By default, all modifier codes are set to 100%, meaning that no charge 

modification will be made to the procedure code fee. To override the value of 
these codes, follow the same process as you did when modifying Fee 
Schedule values. Modifier Values can also be overridden at the time of 
entering the charge. 

 
 
13. Chart Document Templates 
You should insert templates into your chart documents section. Templates act like a 
blank form that you would typically fill out on paper. Good examples of what should 
be inserted as a template are History and Physical forms and Progress Notes. These 
templates can be made to look just like your existing paper forms.  
 
 
 
 
You should first create your templates in Microsoft Word or in the EditLive HTML 
Editor within Renaissance. A good way to create templates is to insert a large blank 
table into the blank document. Type the appropriate field headings.  Use the merge 
cell, split cell, delete cell, delete row, etc. functionality to customize the form to your 
liking. See the example below for a glimpse of a form that was created using this 
method.  
 
Patient Information 
Name:  Date:  

DOB:  Age:  

Sex:  Occupation:  

Location:  Source:  
Unit #:  Acct #:  

Attending:  PCP:  
 

Chief Complaint 
 
 

Present Illness 
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Past History 
General Health:  
Operations:  
Injuries:  
Illnesses:  
Medicines:  
Drug Allergies:  
Food Allergies:  
Other Allergies:  
Habits:  
Bleeding Tendencies:  
Marital Status/Children:  

 
New Chart Document Template 
 
After the template is created, you need to insert the template into your site.  

 
1. Hover over Charts and select Chart Documents.  
2. Click New Chart Document in the left navigation box. 
3. Select the entire document (Ctrl+A) that you have created and copy it 

(Ctrl+C). 
4. Paste the document into the EditLive HTML Editor within Renaissance 

(Ctrl+V). 
5. Ensure that the formatting is the same. 
6. Click on Save As Template. 
7. The Save Template box will appear with the template in the EditLive HTML 

Editor. 
8. Enter the Type. If there is not a Type in the box for that chart template, click 

on the Maintain Picklist icon   directly to the right of the Type drop down list 
and enter a new one. 

9. Enter the Name of the template. 
10. If you want something to always appear in the subject line when you use that 

template, enter it in the Default Subject field.  
11. Select the Scope. If you want this template to be viewed by you only, select 

Personal, if not select Practice. 
12. Click Save. 

 
NOTE: You can add data fields to your templates so that when you select the 
template, the fields automatically populate with the correct information for the 
patient. For instance, you can have the name of the patient automatically appear in a 
name field. See the example below. 
 
The template would appear like this: 
 
Patient Information 
Name: {!Patient_PatientName} Date: {!ChartDocument_DocumentDate}  

 
Upon applying the template it would appear like this: 



 

 

Renaissance Setup Guide - Page 21 of 25 

 

 

Patient Information 
Name: Lebon, Simon Date: 01/31/10 

 
To add these data fields, place your cursor in the position you wish to insert the data 

and click on the Insert Data Field button    within the text editor. In the 
dialogue box that appears, select the field you wish to input and press OK. Then 
Save the template. 
 
Applying a Template 
 
To apply the template to a new chart document, simply select a Patient and the 
Type. In the Apply Template drop-down list choose the appropriate template. It 
will appear in the text editor for you to enter information into the fields. Applying a 
template after you have already begun typing in the EditLive HTML Editor will 
overwrite whatever data was there previously. 
 
If you have any questions about templates contact LeonardoMD Customer Service. If 
you would like LeonardoMD to create templates for you, we will do so for a fee. Fees 
for templates are determined by their complexity. 
 
 
 
 
 
 
 
14. Custom List Views 
You can create custom list views in all sections that provide a standard list. This 
enables you to save a named instance of display fields, sort order and filter criteria 
and then select and apply it to the list. Your practice will become dependent upon 
custom list views. At this point, you should decide what sections will require custom 
list views and create them. You can always create them as needed in the future also. 

New List Views 

1. Click Edit from a list to modify the current list view, Copy List View to 
create a new view based on the current, or Create New List View for a new 
blank view. 

2. In Step 1 - Enter List View Name specify the name that will appear in the 
List View drop-down list. 

3. In Step 2 - Select List View Scope choose Personal if the view is only for 
you or Practice for everyone to use. 

4. In Step 3 - Select Display Fields select up to 12 fields to include in the 
view. If the view is intended for export you can choose include all fields to 
export all of the fields instead of just the fields selected. 
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5. In Step 4 - Select Sort Order (Optional) choose up to two fields to sort by 
and specify the order of Ascending (lowest to highest) or Descending 
(highest to lowest). Only fields selected for display can be sorted on. 

6. In Step 5 - Select Filter Fields (Optional) choose up to eight fields to 
specify filter criteria for, selecting a comparison and specifying values if 
applicable. 

7. Press Save or press Alt+S. 
8. To cancel your changes without saving, click the Cancel button, or press 

Alt+C. 

Filter Field Options 

By specifying filter fields you can utilize a list view as a powerful query and reporting 
tool. If you specify more than one field of criteria the resulting query is AND based, 
meaning that only records that meet all criteria are returned.  

OR comparisons are supported within each field by specifying up to 10 values 
separated by commas. Place quotation marks around text but not around numbers or 
dates. To search for all primary insurance with Blue Cross or Aetna for example, 
specify "Blue Cross", "Aetna" in the Value field. 

To assist with the entry of accurate values click the Select button next to the Value 
field. This will launch a dialog box displaying all unique values that currently exist in 
the specified field. You can select up to 10 values from the list and they will be 
returned to the Value field. Note that there may be times when you are searching on 
a picklist field (such as Status for example) and not all of the possible values for the 
picklist appear in the dialog. This is correct in that only those values that actually 
exist in the data will appear. To include the missing picklist values in your Value field 
for future use, you will need to type the value in the Value field.  

Depending on the data type of the field, there are a number of comparison operators 
available which are detailed in the table below. 

Text Comparisons Description 

Contains The field contains the specified text value somewhere in its text. For example 
cardiovascular would return both cardiovascular stress and evaluation of 
cardiovascular function. The Value field must be specified. 

Doesn't Contain The field does not contain the specified text value anywhere in its text. The Value 
field must be specified. 

Is Equal To The field exactly matches the specified text. The Value field must be specified. 

Isn't Equal To The field does not match the specified text. The Value field must be specified. 

Starts With The field begins with the specified text and is followed by any other text. For 
example cardiovascular would return cardiovascular stress but not 
evaluation of cardiovascular. The Value field must be specified.  

Is Between The field is between two text values, greater than or equal to the first and less 
than or equal to the second. The beginning and ending Value fields must be 
specified. 

Is Blank The field is blank and contains no value. The Value field is not applicable. 

Isn't Blank The field is not blank and contains some value. The Value field is not applicable. 

Is Me (Member 
fields only) 

The field is equal to the currently signed in member. The Value field is not 
applicable. This is available for fields that are typically a staff member such as 
Assigned To, Provider, Created By, etc. 
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Date 
Comparisons 

Description 

Is Equal To The field exactly matches the specified date. The Value field must be specified. 

Isn't Equal To The field does not match the specified date. The Value field must be specified. 

Is Before The field is before the specified date. The Value field must be specified. 

Is After The field is after the specified date. The Value field must be specified. 

Is Between The field is between two dates, greater than or equal to the first and less than or 
equal to the second. The beginning and ending Value fields must be specified. 

Is Yesterday The field is equal to yesterday. The Value field is not applicable. 

Is Today The field is equal to today's date. The Value field is not applicable. 

Is Tomorrow The field is equal to tomorrow's date. The Value field is not applicable. 

Is Last Week The field is equal to the week before this (Sunday through Saturday). The Value 
field is not applicable. 

Is This Week The field is equal to the current week (Sunday through Saturday). The Value field 
is not applicable. 

Is Next Week The field is equal to the week after this (Sunday through Saturday). The Value 
field is not applicable. 

Is Last Month The field is equal to the calendar month prior to this. The Value field is not 
applicable. 

Is This Month The field is equal to the current calendar month. The Value field is not applicable. 

Is Next Month The field is equal to the calendar month after this. The Value field is not 
applicable. 

Is Past The field is less than or equal to today's date. The Value field is not applicable. 

Is Future The field is greater than today's date. The Value field is not applicable. 

Number 
Comparisons 

Description 

Is Equal To The field exactly matches the specified number. The Value field must be specified. 

Isn't Equal To The field does not match the specified number. The Value field must be specified. 

Is Less Than The field is less than the specified number. The Value field must be specified. 

Is Greater Than The field exceeds the specified number. The Value field must be specified. 

Is Between The field is between two numbers, greater than or equal to the first and less than 
or equal to the second. The beginning and ending Value fields must be specified. 

Logical 
Comparisons 

Description 

Is True The field is true, or Yes. The Value field is not applicable. 

Is False The field is false, or No. The Value field is not applicable. 

 
Helpful List View 

Superbills List – Secondary Claims Needed 
 
This custom list view is created in order to generate a list for Superbills that have 
both Primary and Secondary Insurance, in which the Primary Claim has been paid, 
but a balance remains.  In order to display this particular list, you would first need to 
copy the default list view, which can be done by clicking on Copy List View, on the 
Superbills list page.  This allows the default display fields to remain the same. The 
Enter List View Name” should then be changed to reflect a Superbill list for 
Secondary Claims.   
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The Select Filter Fields then must be altered in order to display the correct 
Superbills.  On the first row of Filter Fields, select “Primary Claim Status” for the field 
by browsing through the drop down list, choose “Is Equal To” for Comparison, and 
click on the Select icon to display “Paid” for Value.  The second row of Filter Fields 
should be changed to “Secondary Claims Status” for Field, “Is Equal To” for 
Comparison, and “None” for Value.  Finally the third row of Fields should be 
“Insurance Balance”, “Is Greater Than”, and the number zero (0) for Value.  At this 
point, you should save the custom list view.  These Filter Fields ensure that only Paid 
Superbills that contain an Insurance Balance and a Secondary Insurance Company 
will be displayed. 
 
 
15. Claims Setup 
 
CMS-1500 Form Setup 
 
If using the CMS-1500 form for claims there is relatively little setup that will need to 
be completed prior to use. However, before printing claims you will need to set the 
margin offsets for the particular printer that you will be using. See the LeonardoMD 
Renaissance Help System or contact LeonardoMD Customer Service for help on this 
functionality.  
 
Electronic 837 Claims 
 
Prior to sending electronic claims from LeonardoMD Renaissance, you will need to 
first sign up with a clearinghouse. Contact LeonardoMD Customer Support to find out 
about clearinghouse options. After subscribing with a clearinghouse, you will need to 
enter certain information into the Receivers section within Setup Menu.  
 
 
16. Statement Setup 
 
Return Address 
 
For patient Statements you will need to specify which return address will be 
displayed. For centralized billing, you will want the Practice Address to appear. This 
is the address that appears when you navigate to Setup > Practice Profile (in the 
Practice Information box). You can also specify that the Provider’s Address appear 
as the return address. This is the address that appears in the Provider’s Provider 
Information section within the Staff Member detail page.  
 
To change this address: 

1. Navigate to Setup > Practice Profile. 
2. Click on the Edit button within the Section Settings box. 
3. Scroll down to the Patient Statement Settings section. 
4. For the field Billing Address, select Practice or Provider.  

 
Dunning Statement 
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The Dunning Statement is the message that will appear at the bottom of the 
statement depending on the age of the patient balance. Within the same section 
where the above address change was made, you can customize these messages for 
each aging period.  
 
NOTE: In the Practice Profile > Section Settings you will also find many more 
default settings regarding the setup of Patient Statements. Reading through the 
settings and defaulting those which best fit your practice is advised.   
 
Printing Patient Statements 
 

1. Hover over Reports and select Statements by Patient. 
2. Here you have a defaulted list view titled Statements by Patient w/Patient 

Balance > $0. You can create your own list view if you would like your 
statement list filtered with any other fields.  

3. Click on the Print Statements button   in the Leonardo 
toolbar. 

4. A pop up window will appear in which you may customize your Patient 
Statements appropriately.  Pressing OK will convert the statement into a .PDF 
file.  Clicking the Print icon on the print preview page will print Patient 
Statements for all accounts in the current list. 

 
NOTE: Under the Reports menu you also have the option to print Statements by 
Provider. The default list view in this section is titled Statements by Provider 
w/Patient Balance > $0. This list view will sort statements based on the provider 
listed on each procedure. This list may result in patients receiving multiple 
statements if they have seen several different providers. A separate statement will 
be generated for each provider.  


